


Upozornenie		
	
Tento	materiál	je	informačný	produkt.	Akékoľvek	šírenie	alebo	poskytnutie	tretím	osobám	bez	súhlasu	autora	je	zakázané.	
Také	konanie	môže	byť	právne	napadnuté.	
	
Informácie,	ktoré	nájdete	v	tomto	ebooku,	sú	informatívneho	charakteru	–	nie	sú	to	pravidlá,	podľa	ktorých	sa	musí	
používateľ	držať,	sú	to	zásady.	Dodržiavaním	týchto	zásad	sa	zlepší	vaša	znalosť	Photoshopu	a	nebude	pre	vás	problém	
vytvoriť	si	vlastné	dielo.	
	
	

O	autorovi	
Volám	sa	Marek	Chrenko	a	prevediem	vás	nasledujúcimi	32	stranami.	Pracujem	ako	grafik	a	lektor,	ktorý	učí	ďalších	
študentov	tejto	úžasnej	práci.	Počas	svojho	profesijného	života	som	už	previedol	desiatky	ľudí	svetom	Photoshopu,	ktorí	
sa	dokázali	osamostatniť	a	nájsť	si	prácu	v	tomto	odvetví.	Som	autorom	niekoľkých	grafických	online	kurzov	pod		
platformou	Learn2Code.	
	
	

Čo	sa	naučíte	v	tomto	ebooku?	
Ak	začínate	s	Photoshopom,	bude	to	pre	vás	možno	zložitejšie,	ale	nemusíte	sa	báť.	Všetko	sa	dá	naučiť	pri	trpezlivosti	a	
chuti	ďalej	sa	učiť	a	vzdelávať.	
Tento	ebook	vám	ukáže,	ako	premýšľať	ako	grafik	–	ukáže	4	dôležité	postupy,	ktoré	by	sme	nemali	zanedbať:	

1) Analýza	alebo	ako	si	premyslieť,	čo	chcem	vytvoriť	
2) Ako	nastaviť	farebnú	korekciu	
3) Ako	vytvoriť	tiene	a	svetelné	lúče		
4) Ako	na	finalizačné	úpravy	

	
Sú	to	postupy,	ktoré	sa	používajú	pri	fotomontáži,	pri	retušovaní	alebo	pri	návrhu	titulky	do	časopisu.	
V	tomto	ebooku	nájdete	praktické	klávesové	skratky	a	bežný	postup	ako	pracovať	s	Photoshopom.	Berte	to	ako	návod	na	
zlepšenie	svojich	schopností.	
	
Prajem	príjemné	čítanie	a	veľa	zdaru!	
	
	

Marek	



Čo	sa	naučíte	v	tomto	ebooku?	
	
Obsah:	

1) Ako	na	výbery	vo	Photoshope	
2) Ako	presúvať	jednotlivé	vrstvy	medzi	súbormi	
3) Ako	transformovať	vrstvy	presne	podľa	potreby	
4) Ako	vytvoriť	z	výberu	novú	vrstvu	
5) Čo	sú	masky	vo	Photoshope	a	ako	sa	s	nimi	pracuje,	aký	je	rozdiel	medzi	mäkkým	štetcom	a	tvrdým	štetcom	
6) Práca	s	free	transform	módom	na	veľkej	skale	
7) Ako	funguje	clipping	maska	
8) Ako	sa	pracuje	s	módmi	prelínania	a	štýlmi	vrstiev	
9) Ako	skombinovať	viacero	pozadí	
10) Posledné	výbery	a	ukážka	zdokonalenia	výberu	pomocou	Select	and	Mask	
11) Ako	na	farebné	úpravy	na	vrstvách	
12) Ako	tieňovať	a	osvetliť	vrstvy	
13) Finalizačné	úpravy	

	
Toto	je	len	stručný	výber,	čo	sa	môžete	naučiť	z	tohto	ebooku.	Čítajte	pozorne	a	narazíte	na	ďalšie	dôležité	súvislosti.	 	



Aký	bude	cieľ	tohto	ebooku,	ktorý	ste	si	stiahli?		
Určite	jedným	z	dôvodov	bude	vytvoriť	toto	grafické	dielo:	
	

	
	
Ale	má	to	hlbšiu	myšlienku...		idú	mi	na	nervy	videá,	kde	autori	ukazujú	postupy	bez	toho,	aby	
vysvetlili,	čo	urobili.	Divák	sa	len	bezducho	pozerá	na	svoju	obrazovku	a	myslí	si,	že	rozumie	tomu,	čo	
aktuálne	sleduje.	
	
Z	vlastnej	skúsenosti	viem,	že	ak	by	ste	mali	zopakovať	to,	čo	ste	videli,	tak	by	ste	to	nedali.	
Nepamätali	by	ste	si	to,	a	ak	áno,	nerozumeli	by	ste,	prečo	ste	to	tak	urobili.	
	
Budete	mať	len	niečo	nabifľované,	ako	keď	sme	sa	bifľovali	naspamäť	vzorce	a	iné	poučky,	ktoré	
bežne	v	živote	nevyužijeme.	Spomeniete	si,	aký	je	vzorec	pre	objem	kužeľa?	J	
	
V	tomto	ebooku	uvidíte	textový	postup,	ako	sa	dá	vytvoriť	hore	uvedená	fotomontáž.		
Na	vlastné	oči	uvidíte,	ako	sa	používajú	konkrétne	postupy	alebo	techniky	vo	Photoshope.	Každú	
jednu	časť	vysvetlím:	o	čom	to	je,	na	čo	to	slúži	a	kde	to	môžete	využiť.	
Načo	vám	to	bude?	Naučíte	sa	premýšlať	vo	Photoshope!	Už	nebude	pre	vás	existovať	„Ja	to	neviem	
vytvoriť“,	lebo	získate	prax	a	prehľad,	čo	všetko	sa	dá	vo	Photoshope	vytvoriť.	
Samozrejme,	o	tom	by	sa	dalo	rozprávať	aj	celý	deň.		
	
Vyhovovala	by	vám	viac	video-lekcia	namiesto	čítania,	sledovanie	obrazovky	z	pohodlia	domova,	
kde	vám	lektor	vysvetľuje	detailný	postup	a	nástroje,	ktoré	sa	používajú	a	ktoré	budete	schopný	
vytvoriť	pri	vašich	prácach?	Existuje	aj	taká	možnosť!	Zaobstarajte	si	pre	seba	video-lekciu	

kliknutím	na	tento	odkaz	
Video-lekcia	>>	

	
Účelom	tohto	ebooku	je	hlavne	odovzdať	praktické	know-how,	ktoré	som	nadobudol	pravidelným	
používaním	Photoshopu.		
Na	úvod	musím	zistiť	čo	vôbec	chcem	vytvoriť	a	musím	nájsť	materiál,	teda	fotografie.	
	

(Pod	pojmom	fotomontáž	sa	v	tomto	ebooku	myslí	akékoľvek	grafické	dielo.)	
	

http://fotomontaz.sk/lp-ebook/thx-page-ebook-hybrid/


Kde	mám	hľadať	takýto	materiál?	Na	strednej	škole	sme	sa	smiali	z	učiteľa	informatiky,	lebo	na	
akúkoľvek	našu	otázku	k	preberanej	téme	nás	odkázal	na	Google.	„Pán	profesor,	ako	sa	urobí...?	Použi	
Google!“.		
	
Dnes	sa	z	toho	už	nesmejem,	lebo	na	Googli	nájdeme	všetko,	teda	aj	materiál	pre	našu	fotomontáž.	
V	neposlednom	rade	je	dôležitá	inšpirácia	–	aj	tej	je	na	internete	dosť.	
	
Pripájam	zoznam	nejlepších	stránok,	ktoré	využívam	na	získanie	inšpirácie	alebo	konkrétnych	
modelov	do	fotomontáže.	
	
www.shutterstock.com	
www.stock.adobe.com	
www.devianart.com	
www.freepik.com	
www.fotolia.com	
www.pixabay.com	
	
Tretia	uvedená	stránka	je	pre	mňa	top	z	top.	Nájdeme	tam	bohatý	zdroj	inšpirácie	aj	pripravených	
materiálov	na	stiahnutie	a	zakomponovanie	do	fotomontáže.	Ide	o	zbierku	fotografií,	pripravených	
fotomontáží,	ktoré	slúžia	na	inšpiráciu.	Nájdeme	tam	pripravené	modely	na	stiahnutie	v	rôznych	
pózach	atď...	
	
Posledná	rada	je:	Sťahujte	veľa	materiálu.	Neviete,	čo	vám	bude	presne	sedieť	a	s	čím	budete	naozaj	
spokojní.	
	

	
	
V	tomto	prípade	som	otestoval	rôzne	druhy	tváre	a	najviac	mi	vyhovovala	táto	tvár	vytesaná	do	
kameňa.	K	tomu,	ako	som	tento	efekt	dosiahol,	sa	dostaneme	neskôr	v	tomto	ebooku.	
	
Táto	fotomontáž	bola	zložená	z	8	základných	vrstiev.	
	
V	tejto	časti	sa	naučíte:	

1) Čo	sú	výbery	
2) Čo	sú	masky	
3) Ako	sa	pracuje	so	štetcom	
4) Ako	vieme	spojiť	vrstvy	a	prenášať	ich	medzi	súbormi	
5) Transformovať	vrstvy	
6) Atď...	

https://www.deviantart.com/


1.	Začal	som	výberom	ľavej	skaly.	

	
	
Výbery	vo	Photoshope	slúžia	na	oddelenie	objektu	od	pozadia.	V	tomto	príklade	bude	objektom	skala,	
ktorú	budeme	chcieť	oddeliť	od	pozadia	–	aby	sme	ju	mohli	použiť	pri	našej	fotomontáži.	
	
Existuje	viacero	typov	na	vytvorenie	výberu	vo	Photoshope:		Marquee	tool	(vďaka	nim	vieme	vybrať	
obdĺžnik	alebo	štvorec,	elipsu	alebo	kruh),	Lasso	tools	(je	to	nástroj	na	výber	voľnou	rukou,	teda	to,	
čo	kreslím	na	obrazovke,	tam	vytváram	výber)	alebo	môžeme	použiť	Quick	Selection	tool,	nástroj	na	
rýchly	výber.		
	
Tento	nástroj	odporúčam,	keď	chceme	vytvoriť	relatívne	kvalitný,	ale	rýchly	výber.	
Jednoducho	nakreslíme	na	obrazovku,	čo	chceme	vybrať	a	nástroj	rozpozná,	čo	je	objekt	a	čo	je	
pozadie,	ktoré	budem	musieť	vybrať.	
	
S	výberom	musíme	niečo	urobiť.	Musíme	ho	pretransformovať	na	vrstvu	s	prázdnym	pozadím	a	
objektom.	Zvolíme	záložku	Layer	->	New	->	Layer	via	Copy	alebo	klávesovú	skratku	Ctrl/Cmd	+	J.	
	
Mali	by	sme	sa	dostať	k	niečomu,	ako	je	toto:	

	
Šachovnica	predstavuje	priehľadné	miesto,	teda	kdekoľvek	túto	vrstvu	vložíme,	bude	viditeľná	len	
skala.	
	



2.	Vybraný	objekt	vložíme	do	prázdného	dokumentu		
(2100px	x	1500px)	pomocou	klávesovej	kombinácie	Ctrl/Cmd	+	A,	teda	zvolíme	si	celé	plátno,	
skopírujeme	do	výberu	Ctrl	+	C	a	vložíme	do	želaného	dokumentu	Ctrl	+	V.	
	
V	tomto	ebooku	uvidíte	klávesové	skratky	vo	formáte	Ctrl/Cmd	+	klávesa.	Ctrl	je	na	Windowse	a	

Cmd	je	na	Macu.	
	
	 	



3.	Vrstvu	si	chceme	prehodiť,		
lebo	vidíme,	že	vrch	skaly	smeruje	doprava.		
Budeme	chcieť,	aby	vrch	skaly	smeroval	naopak.	Odzrkadlíme	vrstvu	pomocou	módu	voľnej	
transformácie	–	Ctrl/Cmd	+	T.	
	
Okolo	vrstvy,	na	ktorú	sme	aplikovali	mód	voľnej	transformácie,	by	sme	mali	vidieť	niečo	takéto:	

	
Osem	úchytných	bodov	na	každom	rohu.	Pomocou	nich	dokážeme	meniť	tvar	vrstiev	presne	podľa	
našich	potrieb.	
Keď	klikneme	pravým	tlačidlom	myši	na	túto	vrstvu,	uvidíme	dlhý	zoznam	príkazov	a	na	konci	
zvolíme	Flip	Horizontal.	
	

	
	
Tento	príkaz	odzrkadlí	vrstvu.	
Upravenú	vrstvu	nasmerujeme	pomocou	nástroja	Move	tool	(V)	a	umiestnime	do	ľavého	spodného	
rohu.	
	



Na	svojej	obrazovke	by	sme	mali	vidieť	niečo	takéto:		

	
	
	
	
	
	 	



4.	Vytvoríme	pravú	skalu	s	kamennou	tvárou:	
	

	
Použijeme	tento	obrázok.	
	
Pre	výber	pravej	skaly	použijeme	nástroj	na	rýchly	výber	(Quick	selection	tool)	a	vytvoríme	novú	
vrstvu	z	výberu	(Ctrl/Cmd	+	J	alebo	Layer	->	New	->	Layer	via	Copy).	
	
Na	to,	aby	sme	vytvorili	skalu	ako	ju	vidíme	vo	výsledku,	ju	budeme	musieť	zduplikovať.	
Zduplikovanie	vykonáme	stlačením	klávesovej	skratky	Ctrl/Cmd	+	J	na	zvolenú	vrstvu,	alebo	keď	
presunieme	vrstvu	na	uvedenú	ikonku	v	paneli	Layers	(Vrstvy).	
	

	
	
Na	duplikáte	nastavíme	mód	voľnej	transformácie	(Ctrl/Cmd	+	T)	a	zmeníme	rotáciu	na	vrstve	(klik	
pravým	tlačidlom	a	zvolíme	Rotation,	tretie	zhora).	Potom	už	len	otočíme	vrstvu	podľa	potreby,	
v	tomto	prípade	o	180	stupňov.	Nezabudnime	zvoliť	aj	odzrkadlenie,	Flip	Horizontal.	
	



	
	
Ak	by	sme	to	neurobili,	skala	by	nevyzerala	realisticky.	Na	jednej	strane	dopadá	slnko	a	na	druhej	tieň.	
Na	skalu,	ktorá	bola	otočená	o	180	stupňov,	dopadá	tieň	tam,	kde	by	malo	dopadať	slnko,	a	naoapak.	
Nedáva	to	zmysel.	
	
	 	



5.	Nastavíme	vrstvy,	aby	sa	medzi	sebou	prekrývali,	a	nastavíme	masku.		
Na	čo	je	maska	vo	Photoshope?	
	
Vďaka	maske	dokážeme	upraviť	fotografie	nedeštruktívne.	Maska	dokáže	schovať	určitú	oblasť,	
určité	pixely	na	vrstve,	ktoré	nechceme	vidieť	a	nemusíme	ich	odstrániť	pomocou	gumy	alebo	iných	
deštruktívnych	nástrojov.	Schované	pixely	môžeme	kedykoľvek	opäť	zvýrazniť	a	ďalej	s	nimi	
pracovať.	
	
Masku	nastavíme	kliknutím	na	ikonku	v	paneli	Vrstiev	(1.)	a	po	odkliknutí	sa	vytvorí	maska	na	
zvolenej	vrstve	(2).	
	

	
	
Do	masky	môžeme	kresliť	–	určujeme,	čo	má	byť	viditeľné	a	čo	nemá	byť	viditeľné.	
Maska	rozoznáva	len	dve	farby	–	bielu	a	čiernu!	
Biela	farba	odokrýva	pixely	na	vrstve.	
Čierna	farba	zakrýva	pixely	na	vrstve.	
	
Do	masky	môžeme	kresliť	buď	perom,	prechodmi	(Gradient),	štetcom,	ceruzkou...	
Na	zvolenej	vrstve	(skala	smerujúca	dole)	zakreslím	do	masky	čiernym	štetcom	vrchnú	časť	tak,	aby	
sa	prekryla	s	vrstvou,	ktorá	je	pod	ňou,	teda	skalou	smerujúcou	hore.	
	
Musím	mať	nastavený	tzv.	makký	štetec.	Nechcem	maskovať	tvrdým	štetcom.	



Tvrdosť	štetca	si	nastavujem	v	hornej	časti	(Musím	mať	zvolený	nástroj	Štetec	(B)):

	
	
Mäkký	štetec	je	nastavený	vtedy,	keď	Hardness	je	na	1%.	
	
Aký	je	rozdiel	medzi	tvrdým	a	mäkkým	štetcom?		
	

	
	
Mäkký	štetec	sa	používa	najčastejšie	pri	tieňovaní	alebo	prelínaní	jednotlivých	vrstiev	medzi	sebou.	
Preto	aj	v	tomto	prípade	nastavíme	štetec	Hardness	na	1%	a	prekryjeme	čiernou	farbou	do	masky.	
Maska	by	mala	vyzerať	približne	takto:	
	



	
	
A	vrstvy	by	mali	vyzerať	takto:	

	 	
	
Spojme	tieto	dve	vrstvy,	aby	sme	si	zbytočne	nekomplikovali	život	J	–	tieto	vrstvy	zlúčime	
(zmergujeme)	pomocou	klávesovej	skratky	Ctrl/Cmd	+	E.	
Viacero	vrstiev	zvolíme	tak,	že	podržíme	tlačidlo	Ctrl/Cmd	na	klávesnici	a	klikneme	na	vrstvy,	ktoré	
chceme	zmergovať	a	stlačíme	klávesovú	skratku	(Ctrl/Cmd	+	E).	Vrstvy	sa	zjednotia	a	máme	len	
jednu	vrstvu,	s	ktorou	môžeme	ďalej	pracovať.	
	
	 	



6.		Presuňme	túto	vrstvu	do	dokumentu,	kde	vytvárame	fotomontáž.	
Celé	plátno	zvolíme	pomocou	Ctrl/Cmd	+	A,	skopírujeme	Ctrl/Cmd	+	C	a	vložíme	do	dokumentu,	kde	
to	chceme	mať	Ctrl/Cmd	+	V.	
	
Výsledok	by	mal	vyzerať	takto:	

	
	
Zmeníme	na	vrstve	rotáciu	a	zväčšíme	ju	–	mód	voľnej	transformácie	Ctrl/Cmd	+	T.	
	
Výsledok	by	mal	vyzerať	takto:	

	

	

	

	
	 	



7.	V	nasledujúcom	kroku	vložíme	efekt	„vytesanej	tváre	do	skaly.“	
Malo	by	to	vyzerať	približne	takto:		

	
	
Ak	chcete	na	vlastné	oči	vidieť,	ako	sa	vytvorí	takýto	efekt,	zaobstarajte	si	video	návod,	v	ktorom	
to	je	detailne	vysvetlené	krok	za	krokom.	Naučíte	sa	pracovať	so	štýlmi	vrstiev	a	prelínacími	

módmi.	
Kliknite	na	odkaz	nižšie	a	zaobsatarajte	si	toto	video	a	zlepšite	sa	vo	Photoshope!	

Zaobstarať	video	>>	
	
Najprv	si	pripravíme	tvár,	ktorú	vložíme	do	skaly.	

	 	
Vyberieme	ju	pomocou	Quick	selection	tool	a	vytvoríme	z	toho	novú	vrstvu	(Ctrl/Cmd	+	J).	
Hlavu	umiestníme	takto:	

	
	

http://fotomontaz.sk/lp-ebook/thx-page-ebook-hybrid/


Zduplikujeme	vrstvu	s	veľkou	skalou	a	duplikát	umiestníme	nad	vrstvu	s	hlavou.	

	
	
Skala	by	mala	prekrývať	celú	hlavu.	
	
Znie	to	veľmi	zložito?	Nie	nadarmo	sa	hovorí,	že	lepšie	niečo	jedenkrát	vidieť	ako	stokrát	počuť,	
preto	si	pozrite	jedenkrát	profesionálne	výučbové	video,	kde	je	všetko	vysvetlené	krok	za	krokom.	

Nestrácajte	čas	a	naučte	sa	to	z	videa!	
Získať	výučbové	video	>>	

	
Prečo	takýto	postup?	Nastavíme	si	Clipping	masku.	Clipping	maska	umožňuje	zobraziť	pixely	podľa	
toho,	ako	vyzerá	vrstva	pod	ňou.	Znie	to	opäť	veľmi	zložito,	ale	je	to	jednoduché.	
Clipping	masku	si	nastavím	na	vrstvu	s	názvom	„Skala	duplikat“	klinutím	pravým	tlačidlom	na	vrstvu	
a	zvolíme	príkaz	„Create	Clipping	mask“.	

	
	
	
	
	
	
	
	

http://fotomontaz.sk/lp-ebook/thx-page-ebook-hybrid/


Mali	by	sme	dostať	niečo	takéto:	

	
	
Prípadné	ostré	hrany	po	obvode	hlavy	dokážeme	odstrániť	aplikovaním	masky	na	vrstvu	s	tvárou.	
Zvolíme	mäkký	štetec	a	prebehneme	po	miestach,	ktoré	si	vyžadujú	úpravu.	
	
	 	



8.	Práca	so	štýlmi	vrstiev	a	prelínacími	módmi	
V	tomto	bode	si	vysvetlíme	prácu	so	svetlými	a	tmavými	miestami,	ale	ešte	predtým	si	pripravíme	
pôdu	na	vytvorenie	samotného	efektu	„tvár	v	skale“.	
	
Všetky	tri	vrstvy	označíme	a	vložíme	do	skupiny	–	Ctrl/Cmd	+	G.	
Vrstvu	s	tvárou	zduplikujeme	a	vložíme	nad	všetky	tri	vrstvy	–	mimo	skupiny.	
Mali	by	sme	dosiahnuť	rovnaký	efekt	ako	pred	aplikovaním	Clipping	masky	
	

	
	
s	tým	rozdielom,	že	vrstva	s	tvárou	bude	nad	celou	skupinou.	
	
Ďalší	krok	pozostáva	z	desaturácie	vrstvy	s	tvárou.	Desaturovať	treba	z	toho	dôvodu,	aby	sme	
odstránili	všetky	farby	a	ponechali	len	čiernobielu.	
	
Desaturujeme	vrstvu	klávesovou	skratkou	Ctrl/Cmd	+	Shift	+	U	alebo	použitím	Adjustment	vrstvy	
Hue/Saturation,	aplikujeme	Clipping	masku,	aby	sa	efekt	týkal	len	konkrétnej	vrstvy	a	znížime	
úroveň	saturácie	(stredný	slider)	na	najnižšiu	hodnotu.	
	
Znie	to	veľmi	zložito?	Nie	nadarmo	sa	hovorí,	že	lepšie	niečo	jedenkrát	vidieť	ako	stokrát	„počuť“	
alebo	čítať,	preto	si	pozrite	jedenkrát	profesionálne	výučbové	video,	kde	je	všetko	vysvetlené	krok	

za	krokom.	Nestrácajte	čas	tápaním	vo	Photoshope	a	naučte	sa	to	priamo	z	videa!	
Získať	výučbové	video	>>	

	
Efekt	by	mal	vyzerať	takto:	

	 	
	
Na	túto	vrstvu	aplikujeme	ďalšiu	Adjustment	vrstvu,	úrovne	(Levels)	a	pripneme	ju	k	vrstve	s	tvárou.	
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Ťahajme	pravým	a	ľavým	sliderom	podľa	potreby,	aby	sme	čo	najlepšie	zvýraznili	svetlé	a	tmavé	
miesta	na	tvári:	

	
Adjustment	vrstvu	a	vrstvu	s	tvárou	zmergujeme	–	Ctrl/Cmd	+	E.	
	
Zjednotenú	vrstvu	zduplikujeme	–	Ctrl/Cmd	+	J,	teda	získame	duplikát.	
Na	tomto	mieste	je	dôležité	vysvetliť,	čo	sú	štýly	vrstvy	a	prelínacie	módy	(blending	modes).	

1) Štýly	vrstvy	sa	viažu	na	vrstvu,	preto	sa	to	aj	tak	volá	J.		
2) Vďaka	štýlom	vrstiev	dokážeme	vytvoriť	rôzne	efekty	na	akejkoľvek	vrstve	–	či	textovej,	

rastrovej	alebo	shape	vrstve.	
3) Vieme	vytvoriť	efekty	ako	tieň	alebo	žiara	vo	vnútri	objektu	alebo	vo	vonkajšej	časti.	
4) Tieto	efekty	vieme	vytvoriť	aj	samostatne,	ale	tento	postup	šetrí	čas!!!	

Štýly	vrstvy	aktivujeme	dvojklikom	na	vrstvu	(mimo	textu	na	vrstve).	
	
Prelínací	mód	je	súbor	pravidiel,	podľa	ktorých	sa	jednotlivé	vrstvy	medzi	sebou	prelínajú.	V	praxi	to	
znamená,	že	prelíname	dve	vrstvy	medzi	sebou.	Na	vrchnej	vrstve	nastavíme	prelínací	mód,	teda	
vrchná	vrstva	sa	bude	prelínať	s	vrstvou,	ktorá	je	priamo	pod	ňou.		
Existujú	kategórie	prelínacích	módov:	

1) Normal	–	nedochádza	k	žiadnemu	prelínaniu	medzi	vrstvami	
2) Stmavujúce	prelínacie	módy	–	ich	účel	je	stmaviť	tmavé	pixely	na	vrstve	a	spriehľadniť	

svetlé	pixely.	
3) Zosvetľujúce	prelínacie	módy	–	ich	účel	je	rovnaký	ako	stmavujúce	módy,	ale	presne	opačný	

–	zosvetlia	svetlé	pixely	a	tmavé	spriehľadnia.	
4) Kontrastné	prelínacie	módy	–	ich	účelom	je	dosiahnuť	kontrast,	zvýšiť	sýtosť	farieb	na	

tmavých	aj	svetlých	miestach.	
5) Diferenčné	alebo	inverzné	prelínacie	módy	–	ich	účelom	je	zmeniť	farby	na	opačné,	napr.	

bielu	na	čiernu,	žltú	na	modrú	atď.	Vyskúšajte	si	to	J.	
6) Farebné	prelínacie	módy	–	pracujú	so	sýtosťou	farby	a	dokážu	prelínať	farebné	pixely	medzi	

sebou.	
	
Zoznam	prelínacích	módov	zobrazíme	kliknutím	na	tento	panel:	

	
	



A	takto	vyzerá	kompletný	zoznam	prelínacích	módov:	

	
Na	zduplikovanej	vrstve	s	tvárou	aplikujeme	štýly	vrstvy	–	dvojklikom.	
Zobrazí	sa	nám	nasledujúce	okno:	

	
	
Na	ľavej	strane	vidíme	zoznam	efektov,	ktoré	môžeme	aplikovať	na	vrstvu.	
Zvolíme	Color	Overlay.	Trojica	Color	overlay,	Gradient	overlay	a	Pattern	overlay	vyplní	celú	vrstvu	
podľa	jednej	farby	(color	overlay),	prechodom	medzi	viacerými	farbami	(gradient	overlay)	alebo	
vzorom	(pattern	overlay).	
Máme	zvolený	Color	overlay	a	nastavíme	farbu	na	tmavosivú	(v	mojom	prípade	to	je	kód	#1b1b1a)	
a	nastavíme	prelínací	mód	na	Color	dodge.	

	



Týmto	postupom	sme	docielili,	že	sa	nastavil	ešte	väčší	kontrast	medzi	čiernou	a	bielou	farbou	na	
tvári.	
Na	tejto	vrstve,	kde	máme	nastavený	Color	overlay,	zvolíme	prelínací	mód	na	Multiply.	

	
Na	spodnej	vrstve	s	tvárou	nastavíme	kontrastný	mód	Overlay	a	znížime	priehľadnosť	podľa	potreby.	
Efekt	by	mal	vyzerať	takto:	

	
	
Tmavé	miesta	schováme	pomocou	masky,	ktorú	aplikujeme	na	tvár	aj	na	duplikát	desaturovanej	
tváre.	
Teraz	je	efekt	tváre	v	kameni	hotový:	

	



Nevyzerá	to	na	vašej	obrazovke	takto?	Nie	je	to	najjednoduchší	postup.	Vedieť	nastaviť	prelínacie	
módy	môže	byť	na	začiatku	zložité.	Nestrácajte	čas	a	naučte	sa	to	pomocou	vyúčbového	videa,	
kde	je	všetko	detailne	vysvetlené.	Netrápte	sa	tým,	že	budete	chcieť	samy	zistiť,	ako	dosiahnuť	

tento	efekt.	Nechajte	si	poradiť	od	lektora.	
Získať	výučbové	video	>>	
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9.		Do	fotomontáže	vložíme	pozadie,	resp.	dve	pozadia.	

	a	 	
	
Na	posledé	miesto	pôjde	prvá	fotografia,	ktorú	prekryjeme	pravou	fotografiou.	
Asi	takto:	

	
Na	vrchnej	vrstve	nastavíme	masku	a	prekryjeme	svetlú	časť,	oblaky.	
Mali	by	sme	dosiahnuť	toto:	

	
	
	



10.	Prípravu	fotomontáže	zakončíme	výberom	modelu:	

	
Zvolíme	Quick	selection	tool,	vyberieme	objekt	a	na	dokončenie	tohto	procesu	bude	dôležitý	ešte	
jeden	krok	–	zdokonalenie	výberu	pomocou	rozšírenia	Select	and	Mask.	Prečo	je	potrebné	
zdokonalenie?	Pretože	pomocou	základných	výberov,	ako	je	Quick	selection	tool	alebo	Lasso	tool,	
nedokážeme	vybrať	zložitejšie	objekty,	ako	sú	vlasy,	hriva,	srsť	atď.	
	
Pomocou	Select	and	Mask	dokážeme	určiť,	čo	je	vyberaný	objekt	a	čo	je	pozadie.	
Je	to	veľmi	dôležitý	krok,	pomocou	ktorého	budeme	vedieť	vytvoriť	kvalitnejšie	a	presnejšie	výbery.	
	
Tento	príkaz	nájdeme	v	záložke	Select->Select	and	Mask,	alebo	pri	akomkoľvek	nástroji	na	výber	
v	paneli	rozširujúcich	úprav	hore.	

	
	



Takto	sa	zmenila	pracovná	plocha.	Na	to,	aby	sme	vylepšili	výber,	musíme	zvoliť	štetcový	nástroj	
zakrúžkovaný	vľavo	hore	a	prekresliť	objekt	po	obvode	celého	výberu.	Štetec	porovnáva	pixel	za	
pixelom	a	dokáže	rozlíšiť,	čo	je	objekt	a	čo	je	pozadie.	Zo	začiatku	si	to	bude	vyžadovať	trochu	cviku,	
ale	výsledok	bude	stáť	za	to!	

	
	
Neviete,	ako	použiť	tento	nástroj?	Pozrite	sa,	ako	autor	vo	výučbovom	videu	používa	Select	and	

Mask,	aby	vytvoril	výborný	výber	pri	akejkoľvej	situácii.	
Získať	výučbové	video	>>	

	
Potom	zvolíme	v	pravej	časti	Selection	ako	spôsob,	ktorým	sa	má	vyexportovať	výsledok	a	z	výberu	
vytvoríme	novú	vrstvu	–	Ctrl/Cmd	+	J.	
	
Novú	vrstvu	s	modelom	vložíme	do	fotomontáže	na	ľavú	skalu.	
Budeme	chcieť	vytvoriť	siluetu.	
Jedným	zo	spôsobov	je	použitie	Adjustment	vrstvy	Hue/Saturation,	ktorú	pripneme	na	vrstvu,	aby	sa	
zmenila	len	konkrétna	vrstva,	a	znížime	posledný	slider	Lightness	na	-100.	
	
Výsledok	by	mal	vyzerať	takto:	

	
	
	
Posledný	objekt,	ktorý	pridáme	do	fotomontáže,	bude	mesiac.	Ten	je	vo	formáte	PNG,	čo	znamená,	že	
pozadie	je	priehľadné,	čiže	nemusíme	sa	zaoberať	výberom	objektu.	Jednoducho	vložíme	mesiac	do	
fotomontáže	namiesto	mesiaca	v	hornej	časti.	
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Vytvoríme	masku	na	mesiaci	a	na	spodnej	časti	mäkkým	štetcom	jemne	odstránime	pixely.	
Výsledok	by	mal	vyzerať	takto:	

	
	 	



11.	Prechádzame	do	druhej	fázy,	kde	musíme	nastaviť	rovnaký	farebný	odtieň	
na	všetkých	vrstvách.	
Je	to	veľmi	dôležitá	časť,	nemali	by	sme	to	podceniť,	pretože	vďaka	tomu	dodáme	správny	„look“	
našej	fotomontáži,	ktorá	bude	pôsobiť	profesionálnejšie,	reálnejšie.	
	
Keď	chceme	zjednotiť	farbu	na	vrstvách,	budeme	najviac	využívať	Adjustment	vrstvy,	ktoré	pripneme	
na	konkrétnu	vrstvu.	
Ktoré	Adjustment	vrstvy	budeme	využívať?	

1) Color	Lookup	(táto	Adjustment	vrstva	obsahuje	preddefinované	„situácie“,	podľa	ktorých	
vieme	nastaviť	farbu	na	vrstvách,	ako	napríklad	tma,	zamračené,	hmlisto,	západ	slnka	atď...)		

2) Color	balance	(detailnejší	nástroj,	pomocou	ktorého	dokážeme	presne	vyladiť	farbu	
midtónov,	svetlých	miest	a	tmavých	miest	pomocou	sliderov.	Pri	ťahaní	sliderov	ku	Cyan,	
Green	alebo	Blue	nastavujeme	chladné	odtiene	a	pri	Red,	Magenta	a	Yellow	nastavujeme	teplé	
odtiene.)	

3) Curves	(Zložitejší,	ale	výkonný	nástroj,	pomocou	ktorého	tiež	dokážeme	meniť	farbu	svetlých	
alebo	tmavých	miest	či	midtónov	podľa	krivky.	Miera	zakrivenia	nám	udáva	silu	efektu:	čím	
väčšie	zakrivenie,	tým	silnejší	efekt.	)	

	
Jednotlivé	body	definujú	miesta,	ktore	sa	upravujú	ťahaním	krivky.	

4) Hue/Saturation	(veľmi	šikovný	nástroj,	pomocou	ktorého	môžeme	zmeniť	odtieň	na	
farebných	pixeloch.	Má	niekto	červenú	vetrovku?	Žiadny	problém!	Červenú	vetrovku	
dokážeme	zmeniť	na	modrú.	Už	sme	si	ukazovali	spôsob	použitia	saturácie,	čiže	pomocou	
druhého	slidera	dokážeme	upraviť	sýtosť	farby	a	pomocou	tretieho	slidera	upravujeme	
svietivosť	pixelov.)	

5) Gradient	map	(univerzálny	spôsob	kolorizácie	fotografie;	jednoducho	nastavíme	do	prechodu	
konkrétne	farby,	ktoré	budú	musieť	mať	tmavé	alebo	svetlé	miesta	a	výsledok	je	na	svete...	
máme	kolorizovanú	fotografiu.)	

	
Po	aplikovaní	farebných	zmien	by	mala	fotomontáž	vyzerať	takto:	

	



Na	zlepšenie	efektu	môžeme	pridať	efekt	oblakov	v	ľavej	časti.	Toto	bolo	vytvorené	stiahnutím	
custom	štetca.	Custom	štetce	sú	výborné	riešenie	pre	dodanie	špeciálnych	úprav.	Existujú	rôzne	
druhy	custom	štetcov.	V	tomto	prípade	som	použil	oblakové	štetce,	ktoré	majú	tvar	oblakov	–	podľa	
toho	ten	názov		J.	Pre	rôzne	situácie	existujú	retušovacie	štetce,	tvarové	štetce	atď.	Urýchľuje	to	
prácu,	lebo	nemusíme	stahovať	rôzne	obrázky	a	vtesnať	ich	do	fotografie,	ale	na	čistú	vrstvu	môžeme	
použiť	takýto	štetec.	
	

	 	 		
	

	
Takto	vyzerajú	niektoré	adjustment	úpravy	na	konkrétnych	vrstvách.	
	
Color	lookup	môžeme	použiť	pri	skalách	na	nastavenie	tmavého	odtieňa	noci.	Tieto	adjustment	vrstvy	
môžeme	duplikovať	(Ctrl/Cmd	+	J)	na	zosilnenie	efektu.	
	
Color	balance	využijeme	najmä	pri	jemných	úpravách	a	doladení	farieb.	
	
Hue/Saturation	použijeme	pri	neutralizácii	farieb	–	keď	má	nejaká	vrstva	príliš	intenzívne	farby,	ako	
napríklad	pravá	skala.	
	
Curves	sa	oplatí	použiť	rovnako	ako	Color	balance	na	jemné	estetické	úpravy	alebo	nastavenie	
kontrastu.	
	
Zdá	sa	vám	príliš	zložité	farebné	nastavenie	a	chýba	vám	prax	s	adjustment	vrstvami?	Neváhajte	
a	zaobstarajte	si	výučbové	video,	kde	je	to	detailne	vysvetlené.	Šetrite	svoj	čas,	lektor	vo	videu	

vám	to	podrobne	vysvetlí.	
Získať	výučbové	video	>>	
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12.Prejdeme	k	predposlednej	časti,	a	to	je	nastavenie	tieňov.	
Keď	svieti	slnko,	predmety	vrhajú	tiene.	Tak	je	to	aj	v	prípade	fotomontáže	–	je	veľmi	dôležité	
pamätať	na	správne	nasvietenie	objektov	na	scéne.	
	
V	tomto	prípade	bude	hlavným	zdrojom	svetla	mesiac.	
Preto	si	nastavíme	žiaru	mesiaca	pomocou	vytvorenia	novej	vrstvy	(Ctr/Cmd	+	Shift	+	N)	
a	nastavením	mäkkého	bieleho	štetca.	
Jediné,	čo	nám	ostáva,	je	1x	kliknúť	a	vytvorí	sa	nám	žiadaná	žiara.	(Vrstva	musí	byť	umiestnená	
nad	mesiac).	Intenzitu	môžeme	prispôsobiť	pomocou	Opacity	na	vrstve.	
	
Keď	máme	vytvorený	zdroj	svetla,	bude	dôležité	prispôsobiť	skaly	podľa	toho,	ako	dopadá	slnko.		
	
Na	prispôsobenie	svetelných	podmienok	sa	používa	obyčajná	prázdna	nová	vrstva,	do	ktorej	budeme	
pomocou	čierneho	mäkkého	štetca	vkreslovať	tiene.	
	
V	paneli	rozširujúcich	úprav	nastavíme	Flow.		

			
	
Flow	zaistí	transparentnosť	pri	prekresľovaní	farby.	Čím	viac	budeme	kresliť	po	danom	mieste,	tým	
bude	farba	intenzívnejšia	a	menej	priehľadnejšia.	
	
Takto	dokážeme	pekne	zakresliť	intenzitu	tieňov.	
	
Nesmieme	zabudnúť	pripnúť	(nastaviť	Clipping	masku)	vrstvy	s	tieňami	k	daným	vrstvám	so	
skalami.	
	
Na	modeli	na	skale	nastavíme	tieň	iným	spôsobom.	Otvoríme	si	štýly	vrstiev	a	zapneme	možnosť	
Inner	Shadow.	

	
Pomocou	tohto	nastavenia	môžeme	vytvoriť	žiadaný	efekt	osvetlenia	na	povrchu	podľa	toho,	ako	
svieti	svetlo.	
V	časti	Angle	sme	nastavili	uhol	41	stupňov	–	podľa	toho,	ako	svieti	žiara	mesiaca,	so	slidermi	
Distance	a	Size	sme	nastavili	veľkosť	tieňa	a	farbu	sme	určili	v	hornom	obdĺžniku.	
	



Má	to	chybičku	krásy	–	zadná	časť	plášťa	je	tiež	osvetlená...	a	to	nechceme.	
Z	tohto	efektu	musíme	vytvoriť	novú	vrstvu	a	potom	nežiaducu	časť	zakryť	pomocou	masky.	
	
Novú	vrstvu	z	efektu	vytvoríme	tak,	že	klikneme	pravým	tlačidlom	myšky	na	konkrétny	efekt	
a	zvolíme	Create	Layer:	

	
Vytvorí	sa	nová	vrstva,	na	ktorej	nastavíme	masku	a	zamaskujeme	nežiaduce	časti	pri	plášti.	
	
Fotomontáž	by	mala	vyzerať	takto:		

	
	
	
	 	



13.	Finalizačné	úpravy	
Posledným	krokom	k	„dokonalosti“	sú	finalizačné	úpravy.	Tento	bod	slúži	na	to,	aby	sme	odstránili	
najmä	nedostatky	na	fotomontáži	alebo	na	inom	grafickom	diele.	V	tomto	kroku	môžeme	tiež	nastaviť	
posledné	efekty,	ako	je	napríklad	Gradient	map,	pomocou	ktorej	dokážeme	nastaviť	finálny	„look“.	
	
Aplikujeme	poslednú	uvedenú	vec	–	gradient	map.	
	
Predtým,	ako	začneme	pracovať	na	finalizačných	úpravách,	musíme	zálohovať	celú	prácu.	
	
Prečo?	Lebo	niekoré	filtre	alebo	postupy	sú	deštruktívne,	to	znamená,	že	aplikovaním	konkrétneho	
filtra	sa	už	nebude	dať	vrátiť	zmena	do	pôvodného	stavu.	
	
Na	vytvorenie	zálohy	v	PSD	súbore	môže	slúžiť	klávesová	kombinácia	Ctrl/Cmd	+	Shift	+	Alt	+	E.	
Vytvorí	sa	nová	vrstva,	kde	sa	všetky	predošlé	vrstvy	spoja	a	vytvoria	jednu	novú	finálnu.	
	
Keď	sa	niečo	pokazí,	jednoducho	túto	vrstvu	zmažeme,	vytvoríme	novú	a	pokračujeme	ďalej.	
	
Na	takúto	vrstvu	aplikujeme	v	tomto	prípade	jedinú	finalizačnú	vrstvu	–	Gradient	map.	
	

	
Na	obrázku	vidíme	rozloženie	farieb,	ktoré	prefarbia	scénu	podľa	nastavenia.	
Daný	prechod	som	nastavil	zvolením	predpripraveného	fotografického	prechodu.	
Tieto	prechody	nastavíme	kliknutím	na	ozubené	koliesko	v	hornej	časti	a	zvolením	príkazu	
Photographic	toning.	Nájdeme	prechod	s	názvom	Gold-Selenium	2	a	potvrdíme	OK.	
	
Výsledná	fotomontáž	by	mala	vyzerať	takto:	

	



Gratulujem!	Toto	je	koniec	návodu.	Ste	spokojný	so	svojou	prácou?	Verím,	že	ste	všetkému	rozumeli	
a	podarilo	sa	vám	vytvoriť	takúto	zaujímavú	fotomontáž.	
Máte	nejaké	otázky	alebo	vám	nebolo	niečo	jasné?	Pýtajte	sa,	som	tu	pre	vás.	
Píšte	mi	na	email	marek@fotomontaz.sk	
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